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Chapter I Introduction

1.1 Milesight VMS Pro Introduction

Milesight VMS Pro (Video Management System) is one of the most innovative and most powerful
video management software systems on the market and it will fulfill your highest requirements
and expectations. The simple and intuitive design requires little training while providing easy
access to live and recorded video, facility maps and alarms. The user who has the authority can
configure all server and cameras settings from a central location. Utilize the left panel navigation
tree structure to navigate the server and cameras as well as to access features like searching out
the online server and cameras automatically, checking the information of the server and camera.
Use Client/Server architecture, it is a future-proof network video solution for large projects and
can manage unlimited network cameras via unlimited working servers in different locations. It’s
able to integrate with other cameras over ONVIF.
This manual describes how to use and manage “Milesight VMS Pro” in your network environment.
Some knowledge of network environment would be beneficial to the readers. Should you require
any technical assistance, please contact authorized service center.

1.2 Key Features

 Support 1/ 2/4/ 6/8/ 9/ 13/ 16/ 20/24/30/36/49/ 64 channels playing synchronously
 H.264/MPEG-4 /MJPEG video compression
 Client/Server architecture, support to add multiple-server
 Record locally or to network storage
 Customizable user access levels
 E-mail notification
 Support dual-stream
 4-CH synchronized playback and up to 16-CH asynchronous playback
 Alarm or scheduled recording
 Integrated Motion-Detection from camera
Multiple monitors support
 Human-oriented Milesight UI
 Support ONVIF
 Supprt D3D display mode

app:ds:asynchronous
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Chapter II Installation

2.1 Software Overview

An installation of “Milesight VMS Pro” has two components: Server software and Client software.
“Milesight VMS Server” is the intelligence management system forward the RTSP stream, and the
Client software is used to log in the server and provides the user interface for all tasks including
monitoring, searching, reporting and configuration. “Milesight VMS Client” allows users in different
locations to log into the server. If users have the right, they are able to change the system
configuration.

2.2 System Operating Environment

OS: Windows XP/7/Vista/Server 2000/Server 2008
CPU: 2.4GHZ or faster
Memory: 2G MB or more
Graphic memory: 1G or more
Internet protocol: TCP/IP

2.3 Installation Guide

Run the Milesight VMS Pro installation file and install the programs on your computer by following
the on-screen instructions. After finishing installation, you will find the programs on the start menu
or on the desktop.
Step1: Select the preferred language for this installation.

Figure 2.1
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Step2: Click “Next” to go on.

Figure 2.2

Step3: Read the information to know about Milesight VMS Pro and go on.

Figure 2.3
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Step4: Choose the destination.

Figure 2.4

Step5: Here you need to install “Milesight VMS Client” and “Milesight VMS Server” to complete the
installation.

Figure 2.5
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Step6: Finish the installation.

Figure 2.6



User Manual

7

Chapter III Operations and Settings

3.1 How to Execute Milesight VMS Pro

(1) Start “Milesight VMS Server” first
After installation, you can find it on “Go to” -> “Start All Programs”-> “Milesight VMS Pro” ->
“Milesight VMS Server”, then all the cameras on the server will load automatically.
(2)Then, start “Milesight VMS Client”
After installation, you can find it on “Go to” -> “Start All Programs”-> “Milesight VMS Pro” ->
“Milesight VMS Client”.
When you log in “Milesight VMS Client”, a window will pop up as below. Enter the Username,
Password. The default user name and password is “admin” and “password”. You can also choose
which language to be used for the Client. If the [Auto Login] is selected, “Milesight VMS Client” will
log in without keying in the Username and Password next time.

Figure 3.1
After you click on the “Login” button, the window will pop up as follow. Please wait for a few
seconds. After loading the cameras successfully, “Milesight VMS Client” will come into view.

Figure 3.2
After successful login, the window will pop as follow. It will search online server automatically, and
the users can add servers according to their needs.
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Figure 3.3

3.2 Configration

Before using “Milesight VMS Client” for live view, you need to add the server first. Then you are
able to add the cameras via different servers. Only after adding the server and cameras, can you
use functions like live view, playback, E-map etc.

How to Add Server?
There are two ways to add servers via “Milesight VMS Client”: one way is searching online
automatically, the other is adding manually. After adding successfully, you can see the name of the
server under “Default Group”.

Right-click the “Default Group” and select “Server Management” option, the window will pop up
as follow. Click on the “Search Server” button to search servers automatically, while click on the
“Add Server” button to add manually. Details will be shown in the following figures.

Figure 3.4
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1. Search Server

Click the button, the window will show as below. You can search servers automatically.

Figure 3.5

Item Description
Stop/Rescan When searching the servers, you can stop it and rescan by clicking again.
Select All All the servers will be selected at a time.
Clear All All the servers will be unchecked at a time.
Set Password Enter the password at a time.
OK Click [OK] button to confirm the settings.
Cancel Exit quit.

2. Add Server

When the button is clicked, the window will show as below. You can add the server manually.

Figure 3.6

Item Description
Server Type Choose the VMS Server you use
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Name The name of server.
Port The port of the server.
User Name The user name of the server.
IP IP address of the server.
SQL port SQL port.
Password Password of the server.
Enable Enable or unable the server.

3. Edit Server

When the button is clicked, the window will show as below. Edit the information of the camera.

Figure 3.7

4. Delete Server

Remove the server from “Milesight VMS Client”.

5. Configure Server
Here you can do the settings for the server. Including General Settings, Camera Management,
Schedule Settings, Motion Detection, Network Settings, User Management, Log Management and
Record File Management.
For more details, please refer to the below content “How to Add IP Camera”.
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Figure 3.8

How to Add IP Camera?
After adding the server successfully, you need to configure the server further, including searching
cameras, adding them to the live view window, setting motion detection, setting recording
schedule, etc. Adding, modifying, removing and SMTP for Server could be also set here. The details
are as below.

Figure 3.9

When you click on the “Config Server” button, window pops up as below, including General
Settings, Camera Management, Schedule Settings, Motion Detection, Network Settings, User
Management, and Log Management.
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Figure 3.10

3.2.1 Camera Management

Click “Camera Management” button, the pop-out window is as below.

Figure 3.11
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1. Search Camera

Figure 3.12

Item Description
Stop/Rescan When searching the cameras, you can stop it and rescan by clicking again.
Select All All the cameras will be selected at a time.
Clear All All the cameras will be unchecked at a time.
Set Password Enter the password at a time.
OK Click [OK] button to confirm the settings.
Cancel Exit quit.
Note: Before you register Milesight VMS Pro, you can only add up to 4 cameras. For more
information, please refer to Chapter VII Milesight VMS Server.

2. Add Camera

When the button is clicked, the window will show as below. You can add the camera manually.
1) Through IP address you can add Milesight's cameras and other cameras supporting ONVIF.
2) Through RTSP stream you can add cameras supporting RTSP.
Note: Those options with * are required, including Name, IP, Port, User Name, Password.
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Figure 3.13

3. Edit Camera

When the button is clicked, the window will show as below. Edit the information of the camera.

Figure 3.14
Click on “Video Settings” button, you can change the video parameters here.

Item Description
Video Stream Choose the main stream or 2nd stream to play.
Video Codec Including H.264, MPEG-4, MJPEG.
Frame Size The resolution.
Maximum Frame Rate Maximum refresh rate of frames
Bit Rate Transmit bits of data per second
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Figure 3.15

4. Delete Camera

Remove the camera from “Milesight CMS Client”.

5. Browsing Web

Browse the web of the camera.

6. Modify IP address

Modify the IP address.

3.2.2 General Settings

Click “General” button, the pop-out window is as below. Here you can set the Recording Path
(support multiple disks at the same time), Server Name and Server Port. It’s also able to decide
how long to schedule recording time length, to keep the recorded files and event/alarm log. At the
same time, you can decide whether to delete these files automatically or not and when.

Figure 3.16
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3.2.3 Schedule

Set the time schedule. When the button is clicked, the window will show as below.
Here you can choose the schedule to be an auto recording schedule or an alarm schedule.

Figure 3.17
Step1: Click “Add” button to add a new schedule as a time templet. You can draw the timeline for
each day. Here you can choose the schedule to be an auto recording schedule or an alarm
schedule. Make sure the [Enable] button is checked.

Figure 3.18
The schedule settings include:

Item Description
Name The schedule name.
Enable Enable or disable the schedule.
Date from/Date to Begin or stop to put in the schedule.
Record Type Including alarm and continuous record
Trigger Motion Detection from “Milesight VMS Client” or IPC itself.
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Capture Image Capture how many pictures per second when alarm is triggered.
Pre record Setting length of the pre-alarm recording file. Setting range: 0-9s.
Post record Setting length of the post-alarm recording file. Setting range: 1-1800s.
SMTP Enable to use the SMTP.

Step3: Choose a type under the “Record Type”.
Note: If you choose the “Alarm” type as the record type, you can also do some settings including
“Trigger Condition”, “Action When Alarm is Triggered”.

Figure 3.19
If you choose the “Alarm” type as the record type, the timeline is red. While if you choose the
“Record” type as the record type, the timeline is blue.

Figure 3.20

Note:Left-click to draw the timeline and right-click to cancel again.
Step4: Select the cameras on the left camera list and move them to the right camera list.
Step5: Click [Apply] or [OK] to confirm the settings.
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3.2.4 Motion Detection

Do the alarm settings here. When the button is clicked, the window will show as below.
Draw the areas where to be detected.

Figure 3.21
Step 1: Select the camera on the left tree which you want to set motion detection. Make sure the
“Enable” button is checked. Draw certain areas by mouse.

Item Description
Select All Select all of the area to be detected
Clear All Clear all of the area
Level Different levels to trigger alarm
Detection Interval How often to trigger alarm
Step 2: Select the cameras on the left camera list and move them to the right camera list.
Step 3: Click [Apply] or [OK] to confirm the settings.

3.2.5 Network

Here you can do the settings for SMTP. Click on the “Network” button and the window will pop up
as below.
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Figure 3.22
SMTP: Enter the SMTP server, port, SMTP sender, password and the SMTP receiver, then when the
alarm is triggered, the server will send you an email to inform you what happened. Now we can
support three kinds of encryption types (NO_SECURITY,USE_SSL,USE_TLS). If you are not sure,
contact with the connection provider or the network administrator.
If you want to send a test email, click “Test”.
DDNS: Choose different types of provider, enter the Host name, User name and Password. The
DDNS can translate constant hostnames into changing IP addresses. This is used to provide a
persistent domain name for a resource that may change location on the network.

3.2.6 User Management

Users are managed in the User Management dialog box.
Users can be created, modified, and deleted from the User Management dialog box in “Milesight
VMS Client”. Several properties of a user including User Name and Password can be changed here.
When the button is clicked, it shows as below.
Note: Different users have different permissions to access the server.
User Type:
Administrator: Full access to do any settings.
Operator: Do anything except create a new user.
Viewer: Can’t change any settings but to view.

Figure 3.23
When the “Add” button is clicked, the window will show as below.
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Figure 3.24

3.2.7 LogManagement

When the button is clicked, the window will show as below. You can change the different log under
the option, including “Event Log” and “Alarm Log”.

Figure 3.25

3.3 Settings

Local Settings
This part is mainly used for local settings. Select a disk to store the recorded files and images. You
can also set how long to keep the operation logs and alarm logs here. (Mainly used in the local
recording and snapshot)
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Note: The default disk is the destination disk where you install “Milesight VMS Pro”.
When you click the “Settings->Local Settings” button, the window will show as below.

Figure 3.26
Better Image Quality
Better image quality uses YUV (traditional is RGB) display mode, which can make the whole effect
of video image more clear.
Carousel Settings
Choose an interval between each other. After being set, the cameras in the live view mode will
alternates with different cameras at a time within an interval.
Connect IPC Stream Directly
Decrease the load of the server when connecting IPC stream directly and the server needn’t to
forward the video stream.
Note: We do not recommend that you check this opinion on when several servers connecting with
the same IPC at the same time.

Figure 3. 27
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Audio Alarm

Play audio when alarm is triggered. The Live View page will appear the alarm icon.

Alarm action
Enable alarm pop up: Check on this option. If a camera is not on the live view channel, it also will
pop up when alarm is triggered.
Windows always on top when alarm: Check on this option. If “Milesight VMS Pro” program was
minimized, it’ll restore to the original size when alarm is triggered.

Change Password
Here you can change the password of “Milesight VMS Client”.

3.4 File

File->Lock

When you click the [Lock] button, the GPI page will be locked. Then click it again, the window will
show as below.

Figure 3.28
You have to key in Username and Password to unlock it.

File->Exit

Username and Password are required when logging out “Milesight VMS Client”. And if the [Auto
Login] is checked, “Milesight VMS Client” will log in without keying in the Username and Password
next time.
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Figure 3.29

3.5 Tools

Tool-> Multi Monitor

Now “Milesight VMS Client” support multiple monitors. When click on the “Multi Monitor” button,
the window pops up as follow. “Milesight VMS Client” supports to use up to 4 monitors now. There
are 3 modes you can choose to use in each monitor, including Live Screen mode, Fullscreen mode
and Alarm Screen mode. What you need to do is to drag the cameras to the position of the
monitor you want to show.
Live screen mode: For this mode, you can add any cameras which you want to show on the screen.
Just drag the cameras and move it into the specified monitor.
Fullscreen mode: Click on the main console monitor, double click on the individual position of the
camera, then the live video will be showed in full screen on the specified monitor.
Alarm screen mode: When the camera is triggered, the live video will play on the monitor. (Now
this mode only supports to display 16 channels at the same time)

Figure 3.30
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Tools->Log Management

Please refer to 3.2.7

Tools-> Change Language

Select the language for “Milesight VMS Client”.

3.5 Help

Help-> Online Help
Here you can feedback any questions to Milesight and seek any help from Milesight.
Help-> About Milesight VMS Pro
“Milesight VMS Client” information can be checked here.

Figure 3.31

3.6 Toolbar

Add short cut icons on toolbar as below.

Figure 3.32

Num Item Description
1 Server Settings Please refer to 3.2.1 Server/Client Settings.
2 Lock/Unlock Lock/Unlock “Milesight VMS Client”. For details, please refer to 3.3

File.
3 Display/ Play toolbar Display or hide toolbar.
4 Hide the PTZ Display or hide PTZ interface.

5 Fullscreen
You can view the live video in full screen mode. To return to the
normal screen, press [Esc] button on the keyboard.

6 Live view modes Support 1/ 2/4/ 6/8/ 9/ 13/ 16/ 20/24/30/36/49/ 64 channels
playing synchronously.

7 Synchronous Playback In the playback mode, choose to playback 4 cameras synchronously.
8 Previous Page Switch to the previous group cameras when in carousel mode.
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9 Next Page Switch to the next group cameras when in carousel mode.
10 Start/Stop Carousel Start or stop the carousel mode.
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Chapter IV Live view
“Milesight VMS Client” software provides the user interface for all tasks including monitoring,
searching, reporting and configuration. The interface is shown as below.

Figure 4.1
This part is mainly used for real-time video preview and polling mode setting. The first time
“Milesight VMS Client” is started, you should add some cameras to it. You can add the cameras
manually or by searching cameras. For details, please refer to 3.2.1 Camera Settings-> Add Camera
and 3.2.1 Camera Settings-> Search Camera. After adding the camera, you have to drag it to the
live view window to display the video.
How to Connect the Camera
Step1: Select a camera in window 1.
Step2: Double-click on the camera or drag and drop the camera to the individual position. The
camera is connected automatically and live video will show in the selected window.
Step3: Repeat step1 to 2 to connect other cameras.

Note: Please make sure the camera is available .

How to Disconnect the Camera
Step1: Select a camera in window 1.
Step2: Right click the camera. Select [Enable], the camera will be disconnected. If you want to
connect again, click it again.
Step3: Repeat step 1 to 3 to disconnect other cameras.

4.1 Camera TreeWindow

This part is to display the added camera. There are 3 types shown bellow.

(1) Right-click on the view list
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Pop-up Menu:
New View Create a new view to save the camera
View Management Manage all the saved view

Figure 4.2

(2) Right-click on the group
Pop-up Menu:

Server Management Manage the server.
Server Online Search out the online-server
Play All Play all the live videos.
Stop All Stop all the live videos.

Figure 4.3
Note: The status of server like below means the server is out of connection.

Figure 4.4

(3) Right-click on the server
Pop-up Menu:

Config Server Configure the server.
Search Camera Search out the online-cameras.
Server Information Server information.
Enable Enable/Unable the server.
Enable All Enable all the cameras under the server.
Unable All Unable all the cameras under the server.
Play All Play all the live videos.
Stop All Stop all the live videos.

Figure 4.5

(4) Right-click on the camera
Pop-up Menu:

Camera Information Please refer to 3.2.2 Camera Settings-> Edit
Camera.

Browsing Web Please refer to 3.2.2 Camera Settings-> Browsing
Web.

Enable Connect or Disconnect the camera.
Play Start the live video.
Stop Stop showing all the videos.

Figure 4.6
Item Description Item Description
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available unusable

failed to connect alarm status

Note:When the camera is failed to connect successfully for the first time, it will try to reconnect at
an increasing intervals until it succeed. If it is failed to connect for a long time, drag it into the live
view screen to play again. You can also click the camera and unable it, and then enable it again, it
will connect successfully again.

4.2 Live Toolbar

Figure 4.7
Icon Item Description

Record Record manually. And this icon will turn into .

Audio
Play Audio or stop it. (Audio is unusable in the polling live view
window)

Snapshot Take a snapshot when viewing.
Display Display.

Stop Display Stop showing the videos.
Zoom In Enable to zoom in a specific area of video image with mouse wheel.

Fullscreen
You can view the live window in full screen mode. To return to the
normal screen, press [Esc] button on the keyboard.

4.3 Live ViewWorkspace

This part is used for displaying the live view. Right click the mouse, and the window will show as
follow.

Pop-up Menu:

Figure 4.8

Play Display.
Stop Stop showing the videos.
Remove Remove the camera from the live view window.
Remove All Remove all cameras from the live view window.
16:9 The original screen size can adjust to 16:9.
4:3 The original screen size can adjust to 4:3.
Resize Return to the original screen size.
Mute Stop audio.
Mute All Stop playing all the audios.
Mute Other Stop playing other audios.
Exit Fullscreen Return to the normal screen.
Fullscreen You can view the live video in full screen mode.
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4.4 PTZ control

This part is for the flexibility of remote pan/tilt/zoom through operator control. It is possible to
zoom in on small distant objects with exceptional clarity. The user can easily track objects with high
precision by using a mouse or joystick.

Figure 4.9

Item Description
Speed PTZ rotation speed control.

Brightness A brighter scene appears if a higher level of brightness has been selected.
Contrast The difference in color and light between different parts of an image.
Saturation A vivid scene appears if a higher level of saturation has been selected.
Default The default values of Brightness/Contrast/Saturation.
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Chapter V Playback
In this part, you can search and play back the recorded files of a selected IP camera.
When you click the [Playback] button, the window will show as below.

Figure 5.1

How to Replay the Recorded Files

Way 1: Asynchronous Playback
Step1: Select which camera to replay on the left, and then check it.
Step2: Select a date and the file type you want to search. The File Type includes: All / Manual /
Motion / Schedule.
Step3: Click [Search] button.
Step4: Choose a playback mode, if it`s asynchronous playback, 1/2/4/6/9/13/16 panes modes are
able to use.
Note: Synchronous playback only supports for 4 panes mode.
Step5: Click the file on the list and it will begin to play the recorded files.

Play toolbar

Icon Item Description

Play Play the video.
Pause Pause the video.
Stop Stop the video.

Step forward Step forward the video.
Slow Slow down to catch details.
Fast Speed up to skip some details.
Mute Play or stop audio. (The default state is to play audio)
Zoom Enable to zoom in a specific area of video image with mouse wheel.
Capture Take a snapshot when playing the file.
Record Record the video.
Download Download the recorded files.
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FullScreen Fullscreen

Color of Recorded Files on the List.

Red Refers to those alarm type recorded files.

Blue Refers to those scheduled recorded files.

Operative Skills

Timelines will help you find the correct videos when there are too many files on the list. It's easy to
zoom out the area by scrolling the mouse wheel to find exactly the incident you are looking for.
Take a file near 10:00 for example, when the position of mouse is between 08:00 and 10:00, then
scroll up the mouse wheel, the position of this file will show as follow. Scroll down to turn back.
You can hold down the left mouse and drag the mouse to left or to right (between the intervals
from 00:00 to 24:00) to get the exact recorded files.
Begin:

Figure 5.2
Scroll up 1:

Figure 5.3
Scroll up 2:

Figure 5.4
Scroll up 3:

Figure 5.5
Scroll up 4:

Figure 5.6
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Why 2: Synchronous Playback

Figure 5.7
Step1: Click on the “Sync palyback” button.
Step2: Select the camera to replay on the left, and then check it.
Step3: Select a date and the file type you want to search. The File Type includes: All / Manual /
Motion / Schedule.
Step4: Click [Search] button.
Step4: Click the file on the list and it will begin to play the recorded files.
Note: Synchronous playback only supports for 4 panes mode. If you want to change the camera to
view, just right click on the window, choose the “Remove” option, and drag the different camera to
the window.

Play toolbar
Icon Item Description

Play Begin to play the video.
Pause Pause to play the video.
Stop Stop playing the video.
Slow Slow down to catch details.
Fast Speed up to skip some details.
Zoom Enable to zoom in a specific area of video image with mouse wheel.
Download Download the recorded files.
Fullscreen Fullscreen

How to Export the Recorded Files

Here is for exporting the recorded files from “Milesight VMS Client”.
Over “Milesight VMS Client”, you can export the recorded files to your local PC. Choose the start
time and the stop time for the recorded files, then select the file type, including Alarm Type and
Schedule Type. Then choose a destination where save the files on your local PC. Right-click on the
file list, select the “Export” option to export the recorded files.
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Figure 5.8

How to Import the Recorded Files

Here is for importing the files which were exported to the local PC before to “Milesight VMS
Client”.
Over “Milesight VMS Client”, you can import the exported files in your local PC to “Milesight VMS
Client”. Click Local File and choose Import, find the destination of the exported files, choose what
you want to import, then select the “Confirm” option to import the recorded files.

Figure 5.9
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Chapter VI Map
In this part, you can add an electronic map and different cameras to the map. The display of map
graphics in the Map window can be controlled. The size of the map can be selected, and the map
can be moved in the window to show the area you want to view. Use the zoom in / zoom out
buttons or with the mouse wheel to adjust the map size. Right-click on the map and choose the
“Lock” option, this would prevent the accidental deletion of the map.
It is easy to navigate between different layers of maps, and to show the maps of cameras in various
locations. Here you can add different maps for each server.
Note: Only on the layers of the server, can you drag the cameras to the server map.
When you click the [Map] button, the window will show as below.

Figure 6.1

6.1 Toolbar

Modify When the [Modify] button is clicked, the window will show as below. Different image

formats such as bmp / gif / png /jpg are supported.

Figure 6.2
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Icon Item Description

Delete Map Remove the map from “Milesight VMS Client”.

Zoom In Enlarge the picture to see more details.

Zoom Out Zoom out the map.

Reset Return the map to its original size.

Delete Hot Remove the camera from the map.

6.2 Pop-Up Menu

Right-click the map (anywhere except the cameras). A menu will pop up as figure 6.3.

Lock If the map is locked, you can do nothing with the map
but zoom in or zoom out.

Unlock You can do anything if the map is unlocked.
Figure 6.3

Right-click the camera. A menu will pop up as figure 6.4.

Delete Remove the camera from the map.
Play Live preview.

Figure 6.4

6.3 Add the Hot

Click the camera and drag it to the E-map, then it will be added successfully. After the camera has
been added on the E-map, you can double click on the hot to play.

Figure 6.5
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Chapter VII Milesight VMS Server
An installation of “Milesight VMS Pro” has two components: server software and client software.
The Server functions as the intelligence management system forward the RTSP stream. After you

log on “Milesight VMS Server”, an icon will appear like this .

Right-Click on the icon, the window is shown as below.

Figure 7.1

Item Description
Stop/Start Stop/Start running “Milesight VMS Server”.

Help
Online Help Feedback any questions to Milesight.
About Us About the version information of “Milesight VMS Server”.

Run When Startup Run the program when computer startup.

Register now Activate “Milesight VMS Pro”.

Exit Exit “Milesight VMS Server”.

Figure 7.2
Note: Before activating “Milesight VMS Pro”, you can add up to 8 cameras. If you want to use more
cameras, please contact with Milesight to activate “Milesight VMS Pro” via “Milesight VMS Server”.
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ChapterⅧ Service
Milesight Technology Co., Ltd provides customers with timely and comprehensive technical
support services. End-users can contact your local dealer to obtain technical support. Distributors
and resellers can contact directly with Milesight for technical support.
Technical Support Mailbox: support@milesight.com
Web: http://www.milesight.com
Online Problem Submission System: http://www.milesight.com/service/feedback.asp
Address: Room 202, No.23 Wanghai Road, 2nd Software Park, Xiamen, China
Zip Code: 361006
TEL: +86-592-5922772
FAX: +86-592-5922775

Milesight
More in Sight

http://www.milesight.com
http://www.milesight.com/service/feedback.asp
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